AnyConnect on Mobile Devices

AnyConnect on mobile devices is similar to AnyConnect on Windows, Mac and Linux platforms. This
chapter provides device information, configuration information, support information, as well as other
administrative tasks specific to AnyConnect for mobile devices.

» AnyConnect Operation and Options on Mobile Devices, page 1

» AnyConnect on Android Devices, page 8

» AnyConnect on Apple iOS Devices, page 10

* AnyConnect on BlackBerry Devices, page 14

* AnyConnect on Chrome OS Devices, page 15

» Configure Mobile Device VPN Connectivity on the ASA Secure Gateway, page 16
» Configure Per App VPN, page 17

» Configure Mobile Device Connections in the AnyConnect VPN Profile, page 21

* Automate AnyConnect Actions Using the URI Handler, page 24

» Configure the Network Visibility Module, page 31

* Troubleshoot AnyConnect on Mobile Devices, page 38

AnyConnect Operation and Options on Mobile Devices

About AnyConnect Mobile VPN Connections

This release of the AnyConnect Secure Mobility Client is available on the following mobile platforms:
* Android
* Apple i0S
* BlackBerry
* Chromebook
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. AnyConnect VPN Connection Entries on Mobile Devices

Cisco AnyConnect is provided on the app store for each supported platform, it is not available on
www.cisco.com or distributed from a secure gateway.

AnyConnect mobile apps contain the core VPN client only, they do not include other AnyConnect modules
such as the Network Access Manager, Posture, or Web Security. Posture information, referred to as Mobile
Posture, is provided to the headend using AnyConnect Identify Extensions (ACIDex) when the VPN is
connecting.

An AnyConnect VPN connection can be established in one of the following ways:
* Manually by a user.

» Manually by the user when they click an automated connect action provided by the administrator (Android
and Apple iOS only).

 Automatically by the Connect On-Demand feature (Apple i0S only).

AnyConnect VPN Connection Entries on Mobile Devices
A connection entry identifies the address of the secure gateway by its fully qualified domain name or IP
address, including the tunnel group URL if required. It can also include other connection attributes.

AnyConnect supports multiple connection entries on a mobile device addressing different secure gateways
and/or VPN tunnel groups. If multiple connection entries are configured, it is important that the user knows
which one to use to initiate the VPN connection. Connection entries are configured in one of the following
ways:

» Manually configured by the user. See the appropriate platform user guide for procedures to configure a
connection entry on a mobile device.

* Added after the user clicks a link provided by the administrator to configure connection entries.

See Generate a VPN Connection Entry, on page 25 to provide this kind of connection entry configuration
to your users.

* Defined by the Anyconnect VPN Client Profile.

The AnyConnect VPN Client Profile specifies client behavior and defines VPN connection entries. For
details refer to Configure Mobile Device Connections in the AnyConnect VPN Profile, on page 21.

Tunneling Modes

AnyConnect can operate, in a managed or an unmanaged BYOD environment. VPN tunneling in these
environments operates exclusively in one of the following modes:

* System-tunneling mode—The VPN connections are used to tunnel all data (full-tunneling), or only data
flowing to and from particular domains or addresses (split-tunneling). This mode is available on all
mobile platforms.

* Per App VPN mode—The VPN connection is used for a specific set of apps on the mobile device
(Android and Apple iOS only)

AnyConnect allows the set of apps defined by the administrator on the headend. This list is defined
using the ASA Custom Attributes mechanism. This list is sent to the AnyConnect client, and enforced
on the device. For all other apps, data is sent outside of the tunnel or in the clear.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Secure Gateway Authentication on Mobile Devices .

On Apple i0OS, a managed environment is required to run in this mode. On Android, both managed and
unmanaged environments are supported. On both platforms, in a managed environment, the Mobile
Device Manager must also configure the device to tunnel the same list of apps that AnyConnect is
configured to tunnel.

AnyConnect operates in the mode determined by the configuration information received from the ASA
headend. Specifically, the presence or absence of a Per App VPN list in the Group Policy or Dynamic Access
Policy (DAP) associated with the connection. If the Per App VPN list is present, AnyConnect operates in Per
App VPN mode; if it is absent, AnyConnect operates in system-tunneling mode.

Secure Gateway Authentication on Mobile Devices

Block Untrusted Servers

When establishing a VPN connection, AnyConnect uses the digital certificate received from the secure gateway
to verify the server's identify. If the server certificate is invalid (there is a certificate error due to an expired
or invalid date, wrong key usage, or a name mismatch), or if it is untrusted (the certificate cannot be verified
by a Certificate Authority), or both, the connection is blocked. A blocking message displays, and the user
must choose how to proceed.

The Block Untrusted Servers application setting determines how AnyConnect reacts if it cannot identify the
secure gateway. This protection is ON by default; it can be turned OFF by the user, but this is not recommended.

When Block Untrusted Servers is ON, a blocking Untrusted VPN Server notification alerts the user to this
security threat. The user can choose:

» Keep Me Safe to terminate this connection and remain safe.

» Change Settings to turn the Block Untrusted Servers application preference OFF, but this is not
recommended. After the user disables this security protection, they must reinitiate the VPN connection.

When Block Untrusted Servers is OFF, a non-blocking Untrusted VPN Server notification alerts the user
to this security threat. The user can choose to:

» Cancel the connection and remain safe.
» Continue the connection, but this is not recommended.

* View Details of the certificate to visually determine acceptability.

If the certificate that the user is viewing is valid but untrusted, the user can:

 Import the server certificate into the AnyConnect certificate store for future use and continue the
connection by selecting Import and Continue.

Once this certificate is imported into the AnyConnect store, subsequent connections made to the
server using this digital certificate are automatically accepted.

> Go back to the previous screen and choose Cancel or Continue.

If the certificate is invalid, for any reason, the user can only return to the previous screen and choose
Cancel or Continue.
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Client Authentication on Mobile Devices

A

Leaving the Block Untrusted Servers setting ON (default setting), having a valid and trusted server certificate
configured on your secure gateway, and instructing your mobile users to always choose Keep Me Safe is the
safest configuration for VPN connectivity to your network.

Note

Strict Certificate Trust overrides this setting, see description below.

0CSP Revocation

The AnyConnect client supports OCSP (Online Certificate Status Protocol). This allows the client to query
the status of individual certificates in real time by making a request to the OCSP responder and parsing the
OCSP response to get the certificate status. OCSP is used to verify the entire certificate chain. There is a five
second timeout interval per certificate to access the OCSP responder.

The user can enable or disable OCSP verification in the Anyconnect settings activity, for details see the
Android User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0. We have also added new
API's in our framework which can be used by MDM administrators to control this feature remotely. Currently
we support Samsung and Google MDM.

Strict Certificate Trust

If enabled by the user, when authenticating remote security gateways, AnyConnect disallows any certificate
that it cannot verify. Instead of prompting the user to accept these certificates, the client fails to connect to
security gateways.

Note

This setting overrides Block Untrusted Server.

If not selected, the client prompts the user to accept the certificate. This is the default behavior.

We strongly recommend that you enable Strict Certificate Trust for the AnyConnect client for the following
reasons:

« With the increase in targeted exploits, enabling Strict Certificate Trust in the local policy helps prevent
“man in the middle” attacks when users are connecting from untrusted networks such as public-access
networks.

* Even if you use fully verifiable and trusted certificates, the AnyConnect client, by default, allows end
users to accept unverifiable certificates. If your end users are subjected to a man-in-the-middle attack,
they may be prompted to accept a malicious certificate. To remove this decision from your end users,
enable Strict Certificate Trust.

Client Authentication on Mobile Devices

[ ] Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0

To complete a VPN connection, the user must authenticate by providing credentials in the form of a username
and password, a digital certificate, or both. The administrator defines the authentication method on the tunnel
group. For the best user experience on mobile devices, Cisco recommends using multiple AnyConnect
connection profiles depending on the authentication configuration. You will have to decide how best to balance
user experience with security. We recommend the following:


https://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/user/guide/b_Android_AnyConnect_User_Guide_4-0-x.html
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VPN Authentication Using SAML B

» For AAA-based authentication tunnel groups for mobile devices, the group policy should have a very
long idle timeout, such as 24 hours, to let the client remain in a reconnecting state without requiring the
user to re-authenticate.

» To achieve the most transparent end user experience, use certificate-only authentication. When a digital

certificate is used, a VPN connection is established without user interaction.

In order to authenticate the mobile device to the secure gateway using a certificate, end users must import a
certificate onto their device. This certificate is then available for automatic certificate selection, or it can be
associated with a particular connection entry manually. Certificates are imported using the following methods:

« Imported manually by the user. See the appropriate user guide for procedures to import certificates to
your mobile device.

* Using SCEP. See Configure Certificate Enrollment for details.

 Added after the user clicks a link provided by the administrator to import a certificate.

See Import Certificates, on page 30 to provide this kind of certificate deployment to your users.

VPN Authentication Using SAML

You can use SAML 2.0 integrated with ASA release 9.7.1 for initial session authentication. To provide a
seamless reconnect without disruption, AnyConnect intentionally skips the repeating of the SAML
authentication process. Additionally, if the user logs out of the IdP using a browser, the AnyConnect session
remains intact.

Follow these guidelines when using SAML:

* You must synchronize your ASA's Network Time Protocol (NTP) server with the IdP NTP server in
order to use the SAML feature.

» The VPN Wizard on ASDM does not currently support SAML configurations.
* You cannot access internal servers with SSO after logging in using an internal IdP.

» The SAML IdP NamelD attribute determines the user's username and is used for authorization, accounting,
and VPN session database.

* You should set Auto Reconnect to ReconnectAfterResume in the AnyConnect Profile Editor, Preferences
(Part 1) if you want users to re-authenticate with the Identity Provider (IdP) every time they establish a
VPN session via SAML.

For AnyConnect Mobile the following platforms and versions are supported:

* Chrome OS 4.0.10151

Refer to the SSO Using SAML 2.0 section in the appropriate release, 9.7 or later, of the Cisco ASA Series
VPN Configuration Guide for additional configuration details.

Localization on Mobile Devices

AnyConnect Secure Mobility Client for Android and Apple iOS supports localization, adapting the AnyConnect
user interface and messages to the user’s locale.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Localization on Mobile Devices

Prepackaged Localization
The following language translations are included in the AnyConnect Android and Apple iOS apps:

* Canadian French (fr-ca)

¢ Chinese (Taiwan) (zh-tw)

* Czech (cs-cz)

* Dutch (nl-nl)

* French (fr-fr)

» German (de-de)

* Hungarian (hu-hu)

« Italian (it-it)

* Japanese (ja-jp)

* Korean (ko-kr)

* Latin American Spanish (es-co)

* Polish (pl-pl)

* Portuguese (Brazil) (pt-br)

* Russian (ru-ru)

« Simplified Chinese (zh-cn)

* Spanish (es-es)
Localization data for these languages is installed on the mobile device when AnyConnect is installed. The
local specified on your mobile device determines the displayed language. AnyConnect uses the language
specification, then the region specification, to determine the best match. For example, after installation, a

French-Switzerland (fr-ch) locale setting results in a French-Canadian (fr-ca) display. AnyConnect Uls and
messages are translatednyConnect when AnyConnect starts.

Downloaded Localization

For languages not in the AnyConnect package, administrators add localization data to the ASA to be downloaded
to the device upon AnyConnect VPN connectivity.

Cisco provides the anyconnect.po file, including all localizable AnyConnect strings, on the product download
center of Cisco.com. AnyConnect administrators download the anyconnect.po file, provide translations for
the available strings, and then upload the file to the ASA. AnyConnect administrators that already have an
anyconnect.po file installed on the ASA will download this updated version.

Initially, the AnyConnect user interface and messages are presented to the user in the installed language. When
the device user establishes the first connection to the ASA, AnyConnect compares the device’s preferred
language to the available localization languages on the ASA. If AnyConnect finds a matching localization
file, it downloads the localized file. Once the download is complete, AnyConnect presents the user interface
and user messages using the translated strings added to anyconnect.po file. If a string was not translated,
AnyConnect presents the default English strings.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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FIPS and Suite B Cryptography on Mobile Devices .

See Import Translation Tables to the Adaptive Security Appliance, on page 7 for instructions on configuring
localization on an ASA. If the ASA does not contain localization data for the device’s locale, the preloaded
localization data from the AnyConnect application package continues to be used.

More Ways to Provide Localization on Mobile Devices
Localize the AnyConnect Ul and Messages, on page 31 by providing a URI link to the user.

Ask your mobile device users to manage localization data on their own device. See the appropriate User Guide
for procedures to perform the following localization activities:

* Import localization data from a specified server. The user chooses to import localization data and specifies
the address of the secure gateway and the locale. The locale is specified per ISO 639-1, with the country
code added if applicable (for example, en-US, fr-CA, ar-1Q, and so on). This localization data is used
in place of the prepackaged, installed localization data.

* Restore default localization data. This restores the use of the preloaded localization data from the
AnyConnect package and deletes all imported localization data.

Import Translation Tables to the Adaptive Security Appliance

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Procedure

Download the desired translation table from www.cisco.com.

In ASDM go to Configuration > Remote Access VPN > Network (Client) Access > AnyConnect
Customization/Localization > GUI Text and Messages.

Click Import. The Import Language Localization Entry window displays.
Choose the appropriate Language from the drop-down list.
Specify where the translation table will be imported from.

Click Import Now. This translation table will be deployed to AnyConnect clients with this preferred language.
Localization will be applied after AnyConnect restarts and connects.

Note

For AnyConnect running on non-mobile devices, the Cisco Secure Desktop translation table must also be
imported onto the Adaptive Security Appliance for Host Scan messages to be localized, even if Cisco
Secure Desktop is not being used.

FIPS and Suite B Cryptography on Mobile Devices

AnyConnect for mobile devices incorporates Cisco Common Cryptographic Module (C3M), the Cisco SSL
implementation which includes FIPS 140-2 compliant cryptography modules and NSA Suite B cryptography
as part of its Next Generation Encryption (NGE) algorithms. Suite B cryptography is available for [IPsec VPNs
only; FIPS-compliant cryptography is available for both IPsec and SSL VPNs.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0 -
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AnyConnect on Android Devices

Use of cryptography algorithms is negotiated with the headend while connecting. Negotiation is dependent
on the capabilities of both ends of the VPN connection. Therefore, the secure gateway must also support
FIPS-compliant and Suite B cryptography.

The user configures AnyConnect to accept only NGE algorithms during negotiation by enabling FIPS Mode
in the AnyConnect app settings. When FIPS Mode is disabled, AnyConnect also accepts non-FIPS cryptography
algorithms for VPN connections.

Additional Mobile Guidelines and Limitations

* Apple iOS 5.0 or later is required for Suite B cryptography; this is the minimum Apple iOS version that
supports ECDSA certificates used in Suite B.

* Android 4.0 (Ice Cream Sandwich) or later is required for Suite B cryptography; this is the minimum
Android version that supports ECDSA certificates used in Suite B.

* A device that is running in FIPS mode is not compatible with using SCEP to provide mobile users with
digital certificates by proxy method or legacy method. Plan your deployment accordingly.

AnyConnect on Android Devices

Refer to the Release Notes for Cisco AnyConnect Secure Mobility Client, Release 4.0.x for Android for
features and devices supported by this release.

Refer to the Android User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0 to install, upgrade,
and use the AnyConnect app.

Guidelines and Limitations for AnyConnect on Android

» AnyConnect for Android supports only the VPN features that are strictly related to remote access.

» AnyConnect for Android supports only the Network Visibility Module, it does not support any other
AnyConnect modules.

» The ASA does not provide distributions and updates for AnyConnect for Android. They are available
only on Google Play.

» AnyConnect for Android supports connection entries that the user adds and connection entries populated
by an AnyConnect profile pushed by an ASA. The Android device supports no more than one AnyConnect
profile, which is the last one received from a headend. However, a profile can consist of multiple
connection entries.

« If users attempt to install AnyConnect on devices that are not supported, they receive the pop-up
messageInstallation Error: Unknown reason -8. This message is generated by the Android OS.

» When users have an AnyConnect widget on their home screen, the AnyConnect services are automatically
started (but not connected) regardless of the "Launch at startup" preference.

» AnyConnect for Android requires UTF-8 character encoding for extended ASCII characters when using
pre-fill from client certificates. The client certificate must be in UTF-8 if you want to use prefill, per the
instructions in KB-890772 and KB-888180.

» AnyConnect blocks voice calls if it is sending or receiving VPN traffic over an EDGE connection per
the inherent nature of EDGE and other early radio technology.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Android Specific Considerations .

* Some known file compression utilities do not successfully decompress log bundles packaged with the
use of the AnyConnect Send Log button. As a workaround, use the native utilities on Windows and Mac
OS X to decompress AnyConnect log files.

Android Specific Considerations

Android Mobhile Posture Device ID Generation

Upon a fresh installation, or after the user clears the application data, AnyConnect now generates a unique
256-byte device ID, which is based on the Android ID. This ID replaces the legacy 40-byte device ID based
on the IMEI and MAC address generated in earlier releases.

If an earlier version of AnyConnect is installed, a legacy ID has already been generated. After upgrading to
this version of AnyConnect, this legacy ID continues to be reported as the Device Unique ID until the user
clears the application data or uninstalls AnyConnect.

Generated device IDs can be viewed after the initial application launch from the AnyConnect Diagnostics >
Logging and System Information > System > Device Identifiers screen, or inside the AnyConnect log in
the device identifiers.txt file, or on the About Screen.

Note

DAP policies on the secure gateway will need to be updated to use the new device IDs.

The pevice-1D is determined as follows:

Device-ID = bytesToHexString (SHA256 (Android-ID))
Where the android-1D and bytesToHexString are defined as follows:

Android-ID = Secure.getString(context.getContentResolver(), Secure.ANDROID ID)
String bytesToHexString (byte[] shaz256rawbytes) {
String hashHex = null;
if (sha256rawbytes != null) {
StringBuffer sb = new StringBuffer (sha256rawbytes.length * 2);
for (int i = 0; i < sha256rawbytes.length; i++) {
String s = Integer.toHexString (0xFF & sha256rawbytes[i]) .toUpperCase();
if (s.length() < 2) {sb.append("0");}
sb.append(s) ;
}
hashHex = sb.toString();
}

return hashHex; }

Android Device Permissions

The following permissions are declared in the Android manifest file for AnyConnect operation:

Manifest Permission Description

uses-permission: Allows applications to access information about
android.permission.ACCESS NETWORK STATE | networks.

uses-permission: Allows applications to access information about Wi-Fi
android.permission. ACCESS_WIFI_STATE networks.
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Manifest Permission Description
uses-permission: Allows an application to broadcast sticky intents.
android.permission.BROADCAST STICKY These are broadcasts whose data is held by the system

after being finished, so that clients can quickly
retrieve that data without having to wait for the next
broadcast.

uses-permission: android.permission. INTERNET Allows applications to open network sockets.

uses-permission: Allows an application to read from external storage.
android.permission.READ EXTERNAL STORAGE

uses-permission: android.permission.READ LOGS | Allows an application to read the low-level system

log files.
uses-permission: Allows read only access to phone state, including the
android.permission.READ PHONE STATE phone number of the device, current cellular network

information, the status of any ongoing calls, and a list
of any PhoneAccounts registered on the device.

uses-permission: Allows an application to receive the broadcast after
android.permission.RECEIVE BOOT COMPLETED | the system finishes booting.

AnyConnect on Apple i0S Devices

Refer to the Release Notes for Cisco AnyConnect Secure Mobility Client, Release 4.0.x for Apple iOS for
features and devices supported by this release.

Refer to the Apple iOS User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0.x to install,
upgrade, and use the AnyConnect app.

Guidelines and Limitations for AnyConnect on Apple i0S

AnyConnect for Apple iOS supports only features that are related to remote VPN access such as:

» AnyConnect can be configured by the user (manually), by the AnyConnect VPN Client Profile, generated
by the iPhone Configuration Utility (http://www.apple.com/support/iphone/enterprise/), or using an
Enterprise Mobile Device Manager.

» The Apple iOS device supports no more than one AnyConnect VPN client profile. The contents of the
generated configuration always match the most recent profile. For example, you connect to
vpn.examplel.com and then to vpn.example2.com, the AnyConnect VPN client profile imported from
vpn.example2.com replaces the one imported from vpn.examplel.com.

« This release supports the tunnel keepalive feature; however, it reduces battery life of the device. Increasing
the update interval value mitigates this issue.

Apple iOS Connect On-Demand Considerations:

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Guidelines and Limitations for AnyConnect on Apple i0S .

» VPN sessions that are automatically connected as a result of iOS On-Demand logic and have Disconnect
on Suspend configured, are disconnected when the device sleeps. After the device wakes up, On-Demand
logic will reconnect the VPN session when it is necessary again.

» AnyConnect collects device information when the Ul is launched and a VPN connection is initiated.
Therefore, there are circumstances in which AnyConnect can misreport mobile posture information if
the user relies on i0S’s Connect On-Demand feature to make a connection initially, or after device
information, such has the OS version, has changed.

» This only applies in your environment if you are running a Legacy AnyConnect release earlier than
4.0.05032, or an Apple iOS release earlier than 9.3 while using Apple Connect-on-Demand capabilities.
To ensure proper establishment of Connect On-Demand VPN tunnels after updating AnyConnect, users
must manually start the AnyConnect app and establish a connection. If this is not done, upon the next
i0S system attempt to establish a VPN tunnel, the error message “The VPN Connection requires an
application to start up” displays.

Cisco AnyConnect and Legacy AnyConnect are different apps with different app IDs. Hence:

* You cannot upgrade the AnyConnect app from a legacy 4.0.05x or earlier version to the new 4.0.07x
version. Cisco AnyConnect 4.0.07x is a separate app, installed with a different name and icon.

* The different versions of AnyConnect can co-exist on the mobile device, but this is not supported by
Cisco. The behavior may not be as expected if you attempt to connect while having both versions of
AnyConnect installed. Make sure you have only one AnyConnect app on your device and it is the
appropriate version for your device and environment.

* Certificates imported using Legacy AnyConnect version 4.0.05069 and any earlier release, cannot be
accessed or used by the new AnyConnect app release 4.0.07072 or later. MDM deployed certificates
can be accessed and used by both app versions.

* App data imported to the Legacy AnyConnect app, such as certificates and profiles, should be deleted
if you are updating to the new version. Otherwise they will continue to show in the system VPN settings.
Remove app data before uninstalling the Legacy AnyConnect app.

* Current MDM profiles will not trigger the new app. EMM vendors must support VPNType (VPN),
VPNSubType (com.cisco.anyconnect) and ProviderType (packet-tunnel). For integration with ISE, they
must be able to pass the Uniqueldentifier to AnyConnect since AnyConnect no longer has access to this
in the new framework. Please consult with your EMM vendor for how to set this up, some may require
a custom VPN type and others may not have support available at release time.

Using the New Extension Framework in AnyConnect 4.0.07x and later causes the following changes in
behavior from Legacy AnyConnect 4.0.05x:

* The Device ID sent to the head end is no longer the UDID in the new version, and it is different after a
factory reset unless your device is restored from a backup made by the same device.

* You may use MDM deployed certificates, as well as certificates imported using one of the methods
available in AnyConnect: SCEP, manually through the UI, or via the URI handler. The new version of
AnyConnect can no longer use certificates imported via email or any other mechanism beyond these
identified ones.

» When creating a connection entry using the UI, the user must accept the iOS security message displayed.

* A user-created entry with the same name as a downloaded host entry from the AnyConnect VPN profile
will not be renamed until it disconnects, if it is active. Also, the downloaded host connection entry will
appear in the UT after this disconnect, not while it remains connected.
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Apple i0S Specific Considerations

When supporting AnyConnect on Apple i0OS devices, consider:
» The SCEP references in this document apply exclusively to AnyConnect SCEP, not Apple iOS SCEP.

* Push email notifications do not work over VPN because of Apple iOS constraints. However, AnyConnect
works in parallel with externally accessible ActiveSync connections, when the tunnel policy excludes
these from the session.

The Apple iPhone Configuration Utility

The iPhone Configuration Utility (IPCU), available from Apple for Windows or Mac OS X, is used to create
and deploy configurations to an Apple iOS device. This can be done in place of configuring an AnyConnect
client profile on the secure gateway.

The existing IPCU GUI, controlled by Apple, does not know of the AnyConnect IPsec capabilities. Configure
IPsec VPN connections within the existing AnyConnect GUI in IPCU. Use the following URI syntax, as
defined in RFC 2996 in the Server field. This Server field syntax is backward compatible with the documented
usage for configuring SSL VPN connections.

[ipsec://][AUTHENTICATION>[“"<IKE-IDENTITY>“@"]] <HOST>[*."<PORT>][*/"<GROUP-URL>]

Parameter Description
ipsec : Indicates that this is an IPsec connection. If omitted, SSL is assumed.
AUTHENTICATION Specifies the authentication method for an IPsec connection. If omitted,

EAP-AnyConnect is assumed. Valid values are:
* EAP-AnyConnect
* EAP-GTC
* EAP-MDS5
* EAP-MSCHAPvV2
+ IKE-RSA

IKE-IDENTITY Specifies the IKE identify when AUTHENTICATION is set to EAP-GTC,
EAP-MDS5, or EAP-MSCHAPvV2. This parameter is invalid when used for
other authentication settings.

HOST Specifies the server address. The hostname or IP address to be used.
PORT Currently ignored, included for consistency with the HTTP URI scheme.
GROUP=URL Tunnel group name appended to the server name.

Examples:

ipsec://EAP-AnyConnect@asa-gateway.example.com
ipsec://asa-gateway.example.com

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Apple i0S Specific Considerations .

To connect to a standards-compliant Cisco IOS router only, use the following:

ipsec://eap-md5:<identity>@ios-gateway.example.com

Connect-on-Demand Usage Guidelines

The Apple iOS Connect-on-Demand feature lets other applications, such as Safari, start a VPN connection.
Apple iOS evaluates the domain requested by the application against the rules configured for the device's
active connection entry. Apple iOS establishes a VPN connection on behalf of an application only if all of
the following are true:

* A VPN connection is not already established.

* An application compatible with the Apple iOS Connect-on-Demand framework requests a domain.
* The connection entry is configured to use a valid certificate.

* Connect On Demand is enabled in the connection entry.

* Apple iOS fails to match a string in the Never Connect list to the domain request.

« Either of the following is true: Apple iOS matches a string in the Always Connect list to the domain
request (on Apple i0S 6 only). Or a DNS lookup failed, and Apple iOS matches a string in the Connect
if Needed list to the domain request.

Keep in mind the following when using the Connect-on-Demand feature:

« After a VPN connection is initiated using iOS's Connect on Demand, i0OS disconnects the tunnel if the
tunnel is inactive for a particular time interval. See Apple’s VPN Connect-on-Demand documentation
for more information.

* We recommend using the Connect if Needed option if you configure rules. A Connect if Needed rule
starts a VPN connection if the DNS lookup to an internal host fails. It requires a correct DNS configuration
so that hostnames within the enterprise are resolved using internal DNS servers only.

* For mobile devices that have Connect on Demand configured, certificate-based authentication tunnel
groups have a short (60 second) idle timeout (vpn-idle-timeout). Set a short idle timeout if your VPN
session is not critical for an application and does not always need to be connected. The Apple device
closes the VPN connection when it is no longer needed, for example, when the device goes into sleep
mode. The default idle timeout for a tunnel group is 60 minutes.

* Always connect behavior is release dependent:
>On Apple i0S 6, i0S always starts a VPN connection when rules in this list are matched.

°On i0S 7.x, Always Connect is not supported, when rules in this list are matched they behave as
Connect If Needed rules.

° On later releases, Always Connect is not used, configured rules are moved to the Connect If Needed
list and behave as such.
* Apple has introduced a Trusted Network Detection (TND) enhancement to theConnect-on-Demand

feature. This enhancement:

 Extends the Connect-on-Demand functionality by determining whether the device user is on a
trusted network.

° Applies to Wi-Fi connectivity only. When operating over other types of network connections,
Connect on Demand does not use TND to determine whether to connect a VPN.
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°Is not a separate feature and cannot be configured or used outside the Connect-on-Demand
capabilities.

Contact Apple for more information about Connect on Demand Trusted Network Detection in iOS 6.

* The integrated Apple iOS IPsec client and AnyConnect both use the same Apple iOS VPN
Connect-on-Demand framework.

Split DNS Resolution Behavior with Split Tunnel

The ASA split tunneling feature lets you specify which traffic goes over the VPN tunnel and which traffic
goes in the clear. An associated feature called split DNS lets you specify which DNS traffic is eligible for
DNS resolution over the VPN tunnel and which DNS traffic the endpoint DNS resolver handles (in the clear).
Split DNS works differently on Apple iOS devices than on other devices if you also configure split tunneling.
AnyConnect for Apple iOS responds to this command as follows:

* Encrypts only DNS queries for domains in the split-dns list.

AnyConnect tunnels only the DNS queries for the domains specified in the command. It sends all other
DNS queries to the local DNS resolver for resolution in-the-clear. For example, AnyConnect tunnels
only the DNS queries for examplel.com and example2.com in response to the following command:

hostname (config-group-policy)# split-dns value examplel.com example2.com
* Encrypts only DNS queries for the domain in the default-domain command.

If the split-dns none command is present and the default-domain command specifies a domain,
AnyConnect tunnels only DNS queries for that domain and sends all other DNS queries to the local
DNS resolver for resolution in-the-clear. For example, AnyConnect tunnels only the DNS queries for
examplel.com in response to the following commands:
hostname (config-group-policy) # split-dns none
hostname (config-group-policy)# default-domain value examplel.com

* Sends all DNS queries in-the-clear. If the split-dns none and default-domain none commands are
present in the group policy, or if these commands are absent from the group policy but present in the
default group policy, AnyConnect sends all DNS queries to the local DNS resolver for resolution
in-the-clear.

N

Note  If split-dns is not specified, the group policy inherits the spit tunneling domain lists that are present in the
default group policy. To prevent inheriting a split tunneling domain list, use the split-dns none command.

AnyConnect on BlackBerry Devices

Refer to the Release Notes for Cisco AnyConnect Secure Mobility Client, Release 4.0.x for BlackBerry for
features and devices supported by this release.

Refer to the BlackBerry User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0.x to install,
upgrade, and use the AnyConnect app.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
[ 14| |


http://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/release/notes/b_Release_Notes_Blackberry_AnyConnect_4-0-x.html
http://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/user/guide/b_BlackBerry_AnyConnect_User_Guide_4-0-x.html

|  AnyConnect on Mobile Devices
Guidelines and Limitations for AnyConnect on BlackBerry .

Guidelines and Limitations for AnyConnect on BlackBerry

* Enabling Split DNS can break VPN connections. Blackberry supports a maximum of two DNS servers.
Our ASA configured DNS server takes precedence because it is prepended in the DNS server list, so
our ASA configured DNS server is applied to the tun adapter. If the ASA configures two private DNS
servers without DNS forwarding in the ASA side, then DNS resolution of public network will fail.

Work around: Until BlackBerry supports more than 2 DNS servers, the Admin should configure only
one private DNS server on the ASA end.

» AnyConnect VPN profiles which are pushed to devices from an ASA headend, block all untrusted servers
by default. This may be preventing a successful VPN connection. Disable this setting to provide the user
with the option to accept or deny connections to untrusted servers

* [Psec IKEv2 VPN connections must be enabled and configured manually on the device by the user.
Only EAP authentication is supported when connecting to the ASA headend.

AnyConnect on Chrome 0S Devices

Refer to the Release Notes for Cisco AnyConnect Secure Mobility Client, Release 4.0.x for Google Chrome
OS for features and devices supported by this release.

Refer to the Android User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0 to install, upgrade,
and use the AnyConnect app.

Guidelines and Limitations for AnyConnect on Chrome 0S

» When the Chromebook device is managed (enrolled in an Enterprise Chrome Management service),
then AnyConnect cannot access client certificates: client certificate authentication does not work.

* There is limited VPN performance on low-end Chromebooks (chromium issue #514341).

« Auto reconnect, reconnecting the VPN session when the network interface goes down and up, is supported
when using AnyConnect release 4.0.10113 or later with Chrome OS 51 or later. Prior to Chrome 51 and
this AC release, if you lost Wi-Fi, or put your device to sleep, AnyConnect would not be able to reconnect
on its own.

* Unless you are using Chrome OS 45 or later, all server certificates, even fully trusted and valid ones,
received from the secure gateway are seen as untrusted.

* After installing or upgrading AnyConnect on Chrome OS, wait until initializing is complete to configure
AnyConnect. "Initializing, please wait..." is displayed in the AnyConnect app. This process may take a
few minutes.
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Configure Mobile Device VPN Connectivity on the ASA Secure

Gateway

Procedure

Step 1

Refer to the appropriate release of the Cisco ASA 5500-X Series Next-Generation Firewalls, Configuration

Guides for configuration procedures that are common to desktop and mobile endpoints. Consider the following

for mobile devices:

Attribute

ASDM Location

Exception

Home page URL

Configuration > Remote
Access VPN > Network
(Client) Access > Group
Policies > Add / Edit >
Advanced > AnyConnect
Client > Customization

AnyConnect Mobile ignores the home page URL
setting, you cannot redirect mobile clients after
successful authentication.

Name and Aliases
of the AnyConnect
Connection Profile

Configuration > Remote
Access VPN > Network
(Client) Access > AnyConnect
Connection Profiles > Add /
Edit

Do not use special characters in the Name or Aliases
fields of tunnel groups (connection profiles) that are
used for AnyConnect mobile client connectivity. Use
of special characters may cause the AnyConnect client
to display the error message: Connect attempt has
failed after logging that it is Unable to process

response from Gateway.

Dead Peer Detection

Configuration > Remote
Access VPN > Network
(Client) Access > Group
Policies > Add / Edit >
Advanced > AnyConnect
Client

Switch off server-side dead peer detection because it
prevents the device from sleeping. However,
client-side dead peer detection should remain switched
on because it enables the client to determine when
the tunnel is terminated due to a lack of network
connectivity.

SSL Keepalive
Messages

Configuration > Remote
Access VPN > Network
(Client) Access > Group
Policies > Add / Edit >
Advanced > AnyConnect
Client

We recommend disabling these keepalive messages
to conserve the battery life of mobile devices,
especially if client-side dead peer detection is enabled.
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Attribute

ASDM Location

Exception

IPsec over NAT-T
Keepalive Messages

Configuration > Remote
Access VPN > Network
(Client) Access > Advanced
> [Psec > IKE Parameters

Enable IPsec over NAT-T must be selected for
AnyConnect IPsec to work. When enabled, NAT
Keepalive messages are sent every 20 seconds by
default, causing excessive battery drainage on mobile
devices.

To minimally effect battery usage on mobile devices,
we recommend you Set the NAT-T Keepalives to the
maximum value of 3600 because these messages
cannot be disabled.

USethecrypto isakmp nat-traversal 3600
command to specify this in the ASA CLI.

Step2 Configure Mobile Posture (also called AnyConnect Identity Extensions, ACIDex) to accept, deny, or restrict
mobile connections as desired.
See the Configuring Endpoint Attributes Used in DAPs procedure, in the appropriate release of Cisco ASA
5500-X Series Next-Generation Firewalls, Configuration Guides.

Example:

The following attributes are sent by AnyConnect on Apple iOS to the headend when establishing a connection:

endpoint.anyconnect

endpoint.anyconnect.platform="apple-ios";
endpoint.anyconnect.devicetype="iPhone7,2";
endpoint.anyconnect.platformversion="9.0";

endpoint.anyconnect

See Configure Per App VPN, on page 17.

.clientversion="4.0.03004";

.deviceuniqueid="11025£84e99351e807£3583343bfec96351cb416";
Step3 (Optional) Configure Per App VPN tunneling mode.

If Per App VPN tunneling mode is not configured, the AnyConnect app operates in system-tunneling mode.

Configure Per App VPN

Before You Begin

AnyConnect Per App VPN tunneling requires:

* ASA 9.3.1 or later to configure Per App VPN tunneling.

* An AnyConnect v4.0 Plus or Apex license.

AnyConnect Per App VPN supports the following mobile platforms:

* Android devices running Android 5.0 (Lollipop) or later.

* Apple iOS devices running Apple i0OS 8.3 or later configured to use Per App VPN in a Mobile Device
Management (MDM) solution.
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. Install the Cisco AnyConnect Enterprise Application Selector Tool

Step 1
Step 2

Step 3
Step 4

Procedure

Install the Cisco AnyConnect Enterprise Application Selector Tool, on page 18.
Use the Application Selector tool to specify an AnyConnect Per App VPN policy for your platform:

* Define a Per App VPN Policy for Android Devices, on page 19
* Define a Per App VPN Policy for Apple iOS Devices, on page 20

Create Per App Custom Attributes, on page 20 on the ASA.
Assign a Custom Attribute to a Policy on the ASA, on page 21.

Install the Cisco AnyConnect Enterprise Application Selector Tool

Step 1

Step 2

The Application Selector Tool is a standalone application that supports policy generation for both Android
and Apple iOS devices.

Before You Begin

The Cisco AnyConnect Enterprise Application Selector requires Java 7 or later.

Procedure

Download the Cisco AnyConnect Enterprise Application Selector tool from the Cisco.com AnyConnect
Secure Mobility Client v4.x Software Center.

If you are using Android apps in your policy, you must have the Android SDK and the Android SDK Build-tools
installed on your system. If you do not, install them as follows.

a) Install the latest version of the Android SDK Tools for the platform you are running the Application
Selector Tool on.
Install the recommended SDK Tools Only package for your platform using the default paths and settings,
including: Install for All Users, so access to package entities is as described.

b) Using the Android SDK Manager, install the latest version of the Android SDK Build-tools.

What to Do Next

Note

If prompted in the application selector tool, configure access to the Android Asset Packaging Tool, aapt,
by specifying its installed location, Android SDK installation
directory\build-tools\build-tools version number\.

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
[ 18 | |


http://software.cisco.com/download/navigator.html?mdfid=283000185
http://software.cisco.com/download/navigator.html?mdfid=283000185
https://developer.android.com/sdk/index.html#download

|  AnyConnect on Mobile Devices
Define a Per App VPN Policy for Android Devices .

Define a Per App VPN Policy for Android Devices

Your Per App VPN policy consists of a set of rules, where each rule identifies an app whose data flows over
the tunnel. Specify the rule options to more stringently identify the allowable app and its use in your mobile
device environment. The Application Selector tool uses information from the app's package file, * . apk, to
set rule options. See http://developer.android.com/guide/topics/manifest/manifest-element.html for Android
package manifest information.

Before You Begin

The Cisco AnyConnect Enterprise Application Selector requires Java 7 or later.

Procedure

Step1 Start the application selector and choose the Android mobile device platform.
Step2 Set the required App ID field.

* Choose Import from Disk to obtain app-specific package information from an app stored on your local
system.

The APP ID field (a string in reverse-DNS format) is automatically filled in. For example, if choosing
the Chrome app for an Apple iOS policy, the APP ID field is set to com.google.chrome.ios. For Chrome
on Android, it would be set to com.android.chrome.

* Alternatively, you may enter this app-specific information directly.

* Specify reverse-DNS format using a wildcard, for example, specify com.cisco.* to tunnel all Cisco apps,
instead of listing each one in its own rule. The wildcard must be the last character in the APP ID entry.

When configuring Per App VPN in a managed environment, verify that the ASA policy allows the same
apps to tunnel as the MDM policy. Specifying *.* as the APP ID allows ALL apps to tunnel and ensures
that the MDM policy is the only arbiter of tunneled apps.

Step3 (Optional) Select a listed app and configure more parameters if desired.

* Minimum Version—The minimum version of the chosen app as specified in the package's manifest
attribute android: versionCode.

* Match Certificate ID—A digest of the application signing certificate.

* Allow Shared UID—Default value is true. If set to false, applications with an android: sharedUserld
attribute specified in the package manifest will not match this rule, and are prevented from accessing
the tunnel.

Step4 Click File > Save to save this Per App VPN policy.

Step5 Seclect Policy > View Policy to view the representation of the defined policy.
Copy this string, it is the string that becomes the value of a perapp custom attribute on the ASA.
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. Define a Per App VPN Policy for Apple i0S Devices

Define a Per App VPN Policy for Apple i0S Devices

Step 1
Step 2

Step 3
Step 4

The policy for Per App VPN on Apple i0S devices is entirely controlled by the MDM facilities. Therefore,
AnyConnect must allow ALL apps, and MDM must configure per app policies to specify the particular apps
that can be tunneled.

Before You Begin

The Cisco AnyConnect Enterprise Application Selector requires Java 7 or later.

Procedure

Start the application selector and choose the Apple iOS mobile device platform.

Set the required App ID field to *.*.
This setting allows ALL apps to tunnel through AnyConnect and ensures that the MDM per app policy is the
only arbiter of tunneled apps.

Click File > Save to save this Per App VPN policy.

Select Policy > View Policy to view the representation of the defined policy.
Copy this string, it is the string that becomes the value of a perapp custom attribute on the ASA.

Create Per App Custom Attributes

Step 1

Step 2

Step 3
Step 4

Step 5

Procedure

In ASDM, navigate to Configuration > Remote Access VPN > Network (Client) Access > Advanced >
AnyConnect Custom Attributes to configure a custom attribute type.
Choose Add or Edit and set the following in the Create / Edit Custom Attribute Type pane:

a) Enter perapp as the type.
The type must be perapp, it is the only type of attribute understood by the AnyConnect client for Per App
VPN.

b) Enter a description of your choosing.

Click OK to close this pane.

Navigate to Configuration > Remote Access VPN > Network (Client) Access > Advanced > AnyConnect
Custom Attribute Names to configure a custom attribute.
Choose Add or Edit and set the following in the Create / Edit Custom Attribute Name pane:
a) Choose the perapp attribute Type.
b) Enter a Name. This name is used to assign this attribute to a policy.
¢) Add one or more values by copying the BASE64 format from the policy tool and pasting it here.
Each value cannot exceed 420 characters. If your value exceeds this length, add multiple values for the

additional value content. The configured values are concatenated before being sent to the AnyConnect
client.
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Assign a Custom Attribute to a Policy on the ASA

Step 1

Step 2
Step 3
Step 4
Step 5

The perapp custom attribute can be assigned to a Group Policy or a Dynamic Access Policy.

Procedure

Open the policy on the ASA:

* For a Group Policy navigate to Configuration > Remote Access VPN > Network (Client) Access >
Group Policies > Add / Edit > Advanced > AnyConnect Client > Custom Attributes.

* For a Dynamic Access Policy navigate to Configuration > Remote Access VPN > Network (Client)
Access > Dynamic Access Policies Add / Edit . In the Access/Authorization Policy Attributes section
select the AnyConnect Custom Attributes tab.

Click Add or Edit an existing attribute to open the Create / Edit Custom Attribute pane.
Select the predefined perapp attribute type from the drop-down list.
Choose Select Value and select a predefined value from the drop-down list

Click OK to close the open configuration panes.

Configure Mobile Device Connections in the AnyConnect VPN

Profile

Step 1

The AnyConnect VPN Client Profile is an XML file that specifies client behavior and defines VPN connection
entries. Each connection entry specifies a secure gateway that is accessible to the endpoint device and other
connection attributes, policies, and constraints. Use the AnyConnect Profile Editor to create a VPN client
profile that includes host connection entries for mobile devices.

Connection entries defined in the VPN profile delivered to mobile devices from the ASA cannot be modified
or deleted by the user. Users can modify and delete only the connection entries that they create manually.

AnyConnect retains only one current VPN Client Profile on the mobile device at a time. Upon startup of an
automatic or manual VPN connection, the new VPN profile entirely replaces the current profile. If the user
manually deletes the current profile, the profile is removed and all connection entries defined in this profile
are deleted.

Procedure

Configure basic VPN access.
See Configure VPN Access for procedures that are common to desktop and mobile endpoints considering the
following exceptions:
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Profile Attribute Exception

Auto Reconnect For all platforms except Apple iOS, regardless of your Auto Reconnect
specification, AnyConnect Mobile always attempts to
ReconnectAfterResume.

For Apple iOS only, Disconnect On Suspend is supported. When Disconnect
On Suspend is chosen, AnyConnect disconnects and then releases the
resources assigned to the VPN session. It will only reconnect in response
to a user's manual connection or an On Demand connection (if configured).

Local LAN Access AnyConnect Mobile ignores the Local LAN Access setting, always allowing
Local LAN Access regardless of the setting in the Client profile.

Step2 Configure Mobile Specific Attributes:

a) In the VPN Client Profile, select Server List in the navigation pane.

b) Select Add to add a new server entry to the list, or select a server entry from the list and press Edit to
open the Server List Entry dialog box.

¢) Configure mobile specific parameters as described in AnyConnect Profile Editor, Mobile Settings, on
page 22.

d) Click OK

Step3 Distribute the VPN client profile in one of the following ways:
* Configure the ASA to upload a client profile onto the mobile device upon VPN connectivity.

See The AnyConnect Profile Editor chapter for instructions on how to import the VPN client profile to
the ASA and associate it with a group policy.

* Provide the user with an AnyConnect URI link to import a client profile. (Android and Apple iOS only)

See Import a VPN Client Profile, on page 31 to provide this kind of deployment procedure to your
users.

* Have the user import an AnyConnect profile using Profile Management on the mobile device. (Android
and Apple iOS only)

See the appropriate mobile device User Guide for device-specific procedures.

AnyConnect Profile Editor, Mobile Settings

Related Topics: Configure Mobile Device Connections in the AnyConnect VPN Profile, on page 21

Apple i0S / Android Settings

* Certificate Authentication—The Certificate Authentication policy attribute associated with a connection
entry specifies how certificates are handled for this connection. Valid values are:
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> Automatic—AnyConnect automatically chooses the client certificate with which to authenticate
when making a connection. In this case, AnyConnect views all the installed certificates, disregards
those certificates that are out of date, applies the certificate matching criteria defined in VPN client
profile, and then authenticates using the certificate that matches the criteria. This happens every
time the device user attempts to establish a VPN connection.

> Manual—AnyConnect searches for a certificate from the AnyConnect certificate store on the
Android device when the profile is downloaded and does one of the following:

° If AnyConnect finds a certificate based on the certificate matching criteria defined in the
VPN client profile, it assigns that certificate to the connection entry and uses that certificate
when establishing a connection.

» If a matching certificate cannot be found, the Certificate Authentication policy is set to
Automatic.

» If the assigned certificate is removed from the AnyConnect certificate store for any reason,
AnyConnect resets the Certificate Authentication policy to Automatic.

> Disabled—A client certificate is not used for authentication.

* Make this Server List Entry active when profile is imported—Defines a server list entry as the default
connection once the VPN profile has been downloaded to the device. Only one server list entry can have
this designation. The default value is disabled.

Apple iOS Only Setting

* Reconnect when roaming between 3G/Wifi networks—When enabled (default), AnyConnect does
not limit the time that it takes to try to reconnect after losing a connection, after the device wakes up, or
after changes occur in the connection type (such as EDGE(2G), 1xRTT(2G), 3G, or Wi-Fi). This feature
provides seamless mobility with a secure connection that persists across networks. It is useful for
applications that require a connection to the enterprise, but consumes more battery life.

If Network Roaming is disabled and AnyConnect loses a connection, it tries to re-establish a connection
for up to 20 seconds if necessary. If it cannot, the device user or application must start a new VPN
connection if one is necessary.

)

Note  Network Roaming does not affect data roaming or the use of multiple mobile service
providers.

Connect on Demand (requires certificate authorization)—This field allows you to configure the
Connect on Demand functionality provided by Apple iOS. You can create lists of rules that are checked
whenever other applications start network connections that are resolved using the Domain Name System
(DNS).

Connect on Demand is an option only if the Certificate Authentication field is set to Manual or Automatic.
If the Certificate Authentication field is set to Disabled, this check box is dimmed. The Connect on
Demand rules, defined by the Match Domain or Host and the On Demand Action fields, can still be
configured and saved when the check box is dimmed.

Related Topics: Apple iOS Specific Considerations, on page 12
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* Match Domain or Host—Enter the hostnames (host.example.com), domain names (.example.com), or
partial domains (.internal.example.com) for which you want to create a Connect on Demand rule. Do
not enter IP addresses (10.125.84.1) in this field.

* On Demand ActionSpecify one of the following actions when a device user attempts to connect to the
domain or host defined in the previous step:

> Never connect—iOS will never start a VPN connection when rules in this list are matched. Rules
in this list take precedence over all other lists

A

Note  When Connect On Demand is enabled, the application automatically adds the server
address to this list. This prevents a VPN connection from being automatically established
if you try accessing the server’s clientless portal with a web browser. Remove this rule
if you do not want this behavior.

° Connect if Needed—iOS will start a VPN connection when rules in this list are matched only if
the system could not resolve the address using DNS.

> Always Connect—Always connect behaviour is release dependent:
>On Apple iOS 6, i10S will always start a VPN connection when rules in this list are matched.

>Oni0S 7.x, Always Connect is not supported, when rules in this list are matched they behave
as Connect If Needed rules.

> On later releases, Always Connect is not used, configured rules are moved to the Connect If
Needed list and behave as such.

* Add or Delete—Add the rule specified in the Match Domain or Host and On Demand Action fields to
the rules table, or delete a selected rule from the rules table.

Automate AnyConnect Actions Using the URI Handler

The URI handler in AnyConnect lets other applications pass action requests in the form of Universal Resource
Identifiers (URIs) to AnyConnect. To simplify the AnyConnect user setup process, embed URIs as links on
web pages or e-mail messages, and give users instructions to access them.

Before You Begin

» URI handling in the AnyConnect application is disabled by default. Mobile device users allow this
functionality by setting the External Control app setting to Enable or Prompt. When enabled, external
control allows all URI commands without user interaction. When set for prompting, the user is notified
of URI activity and allows or disallows it at request time. You should inform your users how to respond
to prompts associated with URI handling if you are using them.

* You must use URL encoding when entering URI handler parameter values. Use a tool such as the one
in this link to encode an action request. Also, refer to provided examples below.

« In the URI, %20 represents a space, $3a represents a colon (:), $2F represents a forward slash (/), and %40
represents an ampersand (@).
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» Slashes in the URI are optional.

Provide your users with any of the following actions.

Generate a VPN Connection Entry

Use this AnyConnect URI handler to simplify the generation of an AnyConnect connection entry for users.

anyconnect:[//|create[/]?name=Description&host=ServerAddress| & Parameter1=)alue&Parameter2=Value

2

Guidelines

* The host parameter is required, all other parameters are optional. When the action runs on the device,
AnyConnect saves all the parameter values that you enter to the connection entry associated with that
name and host.

* Use a separate link for each connection entry that you want to add to the device. Specifying multiple
create connection entry actions in a single link is not supported.

Parameters

* name—Unique name for the connection entry to appear in the connection list of the AnyConnect home
screen and the Description field of the AnyConnect connection entry. AnyConnect responds only if the
name is unique. We recommend using a maximum of 24 characters to ensure that they fit in the connection
list. Use letters, numbers, or symbols on the keyboard displayed on the device when you enter text into
a field. The letters are case-sensitive.

* host—Enter the domain name, IP address, or Group URL of the ASA with which to connect. AnyConnect
inserts the value of this parameter into the Server Address field of the AnyConnect connection entry.

anyconnect://create/?name=SimpleExample&host=vpn.example.com
anyconnect:create?name=SimpleExample&host=vpn.example.com

* protocol (optional, defaults to SSL if unspecified)—The VPN protocol used for this connection. The
valid values are:

> SSL

°Psec

anyconnect:create?name=ExampleIPsec&host=vpn.company.com&protocol=IPsec

« authentication (optional, applies when protocol specifies [Psec only, defaults to EAP-AnyConnect)—The
authentication method used for an IPsec VPN connection. The valid values are:

° EAP-AnyConnect
*EAP-GTC
*EAP-MD5
°*EAP-MSCHAPv2
*]JKE-RSA
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* ike-identity (required if authentication is set to EAP-GTC, EAP-MDS5, or EAP-MSCAPv2)—The IKE
identify when AUTHENTICATION is set to EAP-GTC, EAP-MD5, or EAP-MSCHAPV2. This parameter
is invalid when used for other authentication settings.

anyconnect:create?name=Description&host=vpn.company.com&protocol=IPsec
&authentication=eap-md5&ike-identity=012A4F8B29A9BCD

netroam (optional, applies to Apple iOS only)—Determines whether to limit the time that it takes to
reconnect after the device wakes up or after a change to the connection type (such as EDGE, 3G, or
Wi-Fi).This parameter does not affect data roaming or the use of multiple mobile service providers. The
valid values are:

° true—(Default) This option optimizes VPN access. AnyConnect inserts the value ON into the
Network Roaming field of the AnyConnect connection entry. If AnyConnect loses a connection,
it tries to establish a new one until it succeeds. This setting lets applications rely on a sustained
connection to the VPN. AnyConnect does not impose a limit on the time that it takes to reconnect.

> false—This option optimizes battery life. AnyConnect associates this value with the OFF value in
the Network Roaming field of the AnyConnect connection entry. If AnyConnect loses a connection,
it tries to establish a a new one for 20 seconds and then stops trying. The user or application must
start a new VPN connection if one is necessary.

anyconnect:create?name=Example%20l&host=vpn.example.com&netroam=true

keychainalias (optional)—Imports a certificate from the System Certificate Store to the AnyConnect
Certificate Store. This option is for the Android mobile platform only.

If the named certifiate is not already in the system store, the user will be prompted to choose and install
it before being prompted to allow or deny it being copied into the AnyConnect store. External Control
must be enabled on the mobile device.

The following example creates a new connection entry named SimpleExample whose IP address is set
to vpn.example.com with the certificate named client assigned to it for authentication.

anyconnect://create/?name=SimpleExampleshost=vpn.example.com&keychainalias=client

usecert (optional)—Determines whether to use a digital certificate installed on the device when
establishing a VPN connection to the host. The valid values are:

> true (default setting)—Enables automatic certificate selection when establishing a VPN connection
with the host. Turning usecert to true without specifying a certcommonname value sets the
Certificates field to Automatic, selecting a certificate from the AnyConnect certificate store at
connection time.

° false—Disables automatic certificate selection.

anyconnect:create?name=Example%20l&host=vpn.example.com&usecert=true

certcommonname (optional, but requires the usecert parameter)—Matches the Common Name of a
valid certificate pre-installed on the device. AnyConnect inserts the value into the Certificate field of
the AnyConnect connection entry.

To view this certificate installed on the device, tap Diagnostics > Certificates. You might need to scroll
to view the certificate required by the host. Tap the detail disclosure button to view the Common Name
parameter read from the certificate, as well as the other values.

« useondemand (optional, applies to Apple iOS only and requires the usecert, certcommonname parameters,
and domain specifications below)—Determines whether applications, such as Safari, can start VPN
connections. Valid values are:
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> false (Default)—Prevents applications from starting a VPN connection. Using this option is the
only way to prevent an application that makes a DNS request from potentially triggering a VPN
connection. AnyConnect associates this option with the OFF value in the Connect on Demand
field of the AnyConnect connection entry.

°true—Lets an application use Apple iOS to start a VPN connection. If you set the useondemand
parameter to true, AnyConnect inserts the value ON into the Connect on Demand field of the
AnyConnect connection entry. (domainlistalways or domainlistifneeded parameter required if
useondemand=true)

anyconnect:create?name=Example%20with%20certificate&host=vpn.example.com
&netroam=true&usecert=true&certcommonname=example-ID&useondemand=true
&domainlistalways=email.example.com,pay.examplecloud.com
&domainlistnever=www.example.com&domainlistifneeded=intranet.example.com

domainlistnever (optional, requires useondemand=true)—Lists the domains to evaluate for a match to
disqualify the use of the Connect on Demand feature. This list is the first one AnyConnect uses to
evaluate domain requests for a match. If a domain request matches, AnyConnect ignores the domain
request. AnyConnect inserts this list into the Never Connect field of the AnyConnect connection entry.
This list lets you exclude certain resources. For example, you might not want an automatic VPN
connection over a public-facing web server. An example value is www.example.com.

domainlistalways(domainlistalways or domainlistifneeded parameter required if
useondemand=true)—Lists the domains to evaluate for a match for the Connect on Demand feature.
This list is the second one AnyConnect uses to evaluate domain requests for a match. If an application
requests access to one of the domains specified by this parameter and a VPN connection is not already
in progress, Apple i0OS attempts to establish a VPN connection. AnyConnect inserts this list into the
Always Connect field of the AnyConnect connection entry. An example value list is

email.example.com, pay.examplecloud.com.

domainlistifneeded (domainlistalways or domainlistifneeded parameter required if
useondemand=true)—AnyConnect evaluates a domain request for a match against this list if a DNS
error occurred. If a string in this list matches the domain, Apple i0S attempts to establish a VPN
connection. AnyConnect inserts this list into the Connect if Needed field of the AnyConnect connection
entry. The most common use case for this list is to obtain brief access to an internal resource that is not
accessible in a LAN within the corporate network. An example value is intranet.example.com.

Use a comma-delimited list to specify multiple domains. The Connect-on-Demand rules support only domain
names, not IP addresses. However, AnyConnect is flexible about the domain name format of each list entry,
as follows:

Match Instruction Example Entry Example Matches | Example Match Failures

Exact prefix and | Enter the prefix, | email.example.com | email.example.com | www.example.com
domain name only. | dot, and domain

email.lexample.com
name.

email.examplel.com

email.example.org
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Match Instruction Example Entry Example Matches | Example Match Failures
Any prefix with the | Enter a dot .example.org anytext.example.org | anytext.example.com
exact domain followed by the anytext. lexample.org
name. The leading | domain name to be ' '

dot prevents matched. anytext.examplel.org

connections to
hosts ending with
*example.com,
such as
notexample.com.

Any domain name | Enter the end of | example.net anytext-example.net | anytext.examplel.net
ending with the the domain name | anytext. anytext.example.net | anytext.example.com
text you specify. | to be matched.

Establish a VPN Connection

Use this AnyConnect URI handler to connect to a VPN allowing users to easily establish VPN connections.
You can also embed additional information in the URI to perform the following tasks:

* Prefill a Username and Password
» Prefill Usernames and Passwords for Double Authentication

* Prefill a Username and Password, and Specify a Connection Profile Alias

This action requires either the name or the host parameters, but allows both using one of the following syntaxes:

anyconnect:[//]connect[/]?[name=Description/host=ServerAddress]
[&Parameter1=/alue&Parameter2=ralue ..]
or

anyconnect:[//]connect[/]?name=Description&host=ServerAddress
[&Parameter1=Value&Parameter2=Value ..]

Guidelines

« If all the parameter values in the statement match those of an AnyConnect connection entry on the device,
AnyConnect uses the remaining parameters to establish the connection.

* If AnyConnect does not match all parameters in the statement to those in a connection entry and the
name parameter is unique, it generates a new connection entry and then attempts the VPN connection.

* Specifying a password when establishing a VPN connection using a URI should be used only in
conjunction with a One Time Password (OTP) infrastructure.

Parameters

* name—Name of the connection entry as it appears in the connection list of the AnyConnect home
window. AnyConnect evaluates this value against the Description field of the AnyConnect connection
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entries, also called name if you used the previous instructions to create the connection entry on the
device. This value is case-sensitive.

* host—Enter the domain name, IP address, or Group URL of the ASA to match the Server Address field
of an AnyConnect connection entry, also called the host if you used the previous instructions to generate
the connection entry on the device.

The Group URL is configured in ASDM by selecting Configuration > Remote Access VPN > Network
(Client) Access > AnyConnect Connection Profiles > Advanced > Group Alias/Group URL >
Group-URL.

* onsuccess—Execute this action if the connection is successful. Platform specific behavior:

> For Apple i0S devices, specify the URL to be opened when this connection transitions into the
connected state, or use the anyconnect:close command to close the AnyConnect GUI.

» For Android devices, specify the URL to opened when this connection transitions into or is already
in the connected state. Multiple onsuccess actions can be specified. AnyConnect always closes the
GUI after a successful connection on Android devices.

* onerror—Execute this action if the connection fails. Platform specific behavior:

*For Apple iOS devices, specify the URL to be opened when this connection fails, or use the
anyconnect:close command to close the AnyConnect GUI.

> For Android devices, specify the URL to be opened when this connection fails. Multiple onerror
actions can be specified. AnyConnect always closes the GUI after a failed connection on Android
devices.

* prefill_username—Provides the username in the connect URI and prefills it in connection prompts.

* prefill_password—Provides the password in the connect URI and pre-fills it in connection prompts.
This field should only be used with connection profiles configured for one-time passwords.

* prefill_secondary_ username—In environments that are configured to require double authentication,
this parameter provides the secondary username in the connect URI and prefills it in the connection
prompts.

* prefill_secondary_password—In environments that are configured to require double authentication,
this parameter provides the password for the secondary username in the connect URI and pre-fills it in
the connection prompts.

* prefill_group_list—The connection alias defined in ASDM by selecting Configuration > Remote
Access VPN > Network (Client) Access > AnyConnect Connection Profiles > Advanced > Group
Alias/Group URL > Connection Aliases.

Examples

* Provide the Connection Name and Hostname or Group URL in a URI:
anyconnect://connect/?name=Example
anyconnect:connect?host=hr.example.com
anyconnect:connect?name=Example&host=hr.example.com
anyconnect://connect/?name=Example&host=hr.example.com/group-url
&prefill username=userl&prefill password=passwordl

» Provide Actions For Success or Failure
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Use the onsuccess or onerror parameters to initiate the opening of a specified URL based on the results
of the connect action:

anyconnect://connect?host=vpn.company.com
&onsuccess=http%$3A%2F%2Fwww.cisco.com
anyconnect://connect?host=vpn.company.com
&onerror=http%$3A%2F%2Fwww.cisco.com%$2Ffailure.html
&onsuccess=http%$3A%2F%2Fwww.cisco.com

On Android you can specify multiple onsuccess actions:
anyconnect://connect?host=vpn.company.com
&onerror=http%$3A%2F%2Fwww.cisco.com%$2Ffailure.html

&onsuccess=http%$3A%2F%2Fwww.cisco.com
&onsuccess=tel:9781111111

On Apple i0S devices, the anyconnect://close command can be used in the onsuccess or onerror parameter
to close the AnyConnect GUI:

anyconnect://connect?host=vpn.company.com
&onsuccess=anyconnect$3A%2F%2Fclose

Provide Connection Information and Prefill a Username and Password in a URI:

anyconnect://connect/?name=Example&host=hr.example.com
&prefill username=userl&prefill password=passwordl
anyconnect:connect?name=Example&host=hr.example.com/group-url
&prefill username=userl&prefill password=passwordl

Provide Connection Information and Prefill Usernames and Passwords for Double Authentication:

anyconnect://connect/?name=Example&host=hr.example.com
&prefill username=userlé&prefill password=passwordl
&prefill secondary username=user2&prefill secondary password=password2

Provide Connection Information, Prefill a Username and Password, and Specify a Connection Profile
Alias:

anyconnect://connect/?name=Example&host=hr.example.com
&prefill username=userl&prefill password=passwordl
&prefill group 1list=10.%20Single%20Authentication

Disconnect from a VPN

Use this AnyConnect URI handler to disconnect the user from a VPN.

anyconnect:[//]disconnect[/]&onsuccess=URL

Parameters

The onsuccess parameter applies to Android devices only. Specify the URL to opened when this connection
disconnects or is already in the disconnected state.

Example

anyconnect:disconnect

Import Certificates

Use this URI handler command to import a PKCS12 encoded certificate bundle to the endpoint. The
AnyConnect client authenticates itself to the ASA using a PKCS12 encoded certificate that has been installed
on the endpoint. Only pkes12 certificate type is supported.

anyconnect:[//]limport[/]?type=pkes12&uri=htp%3A4%2F %2 Fexample.com%2F certificatename.p12

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Parameters
* type—Only pkcs12 certificate type is supported.

* uri—URL encoded identifier where the certificate is found.

Examples

anyconnect:import?type=pkcsl2&uri=http%3A%2F%2Fexample.com$2FCertName.pl2

Import a VPN Client Profile

Use this URI handler method to distribute client profiles to AnyConnect clients.

anyconnect:[//]limport[/]?type=profile&uri=filename.xml

Example

anyconnect:import?type=profilesuri=£file%$3A%2F%2Fsdcard%2Fprofile.xml

Localize the AnyConnect Ul and Messages

Use this URI handler method to localize the AnyConnect client.
anyconnect:[//limport[/]?type=localization&lang=LanguageCode&host=ServerAddress

Parameters

The import action requires all parameters.
* type—The import type, in this case localization.

* lang—The two- or four-character language tag representing the language provided in the anyconnect.po
file. For example, the language tag may simply be fr for “French” or fr-ca for “Canadian French.”

* host—Enter the domain name or IP address of the ASA to match the Server Address field of an
AnyConnect connection entry.

Example

anyconnect:import?type=localization&lang=fr&host=asa.example.com

Configure the Network Visibility Module

About Network Visibility Module

Because users are increasingly operating on unmanaged devices, enterprise administrators have less visibility
into what is going on inside and outside of the network. The Network Visibility Module (NVM) collects rich
flow context from an endpoint on or off premise and provides visibility into network connected devices and
user behaviors when coupled with a Cisco solution such as Stealthwatch, or a third-party solution such as

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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Splunk. The enterprise administrator can then do capacity and service planning, auditing, compliance, and
security analytics. NVM provides the following services:

* Monitors application use to enable better informed improvements (expanded IPFIX collector elements
in VzFlow protocol specification) in network design.

* Classifies logical groups of applications, users, or endpoints.

* Finds potential anomalies to help track enterprise assets and plan migration activities.

This feature allows you to choose whether you want the telemetry targeted as opposed to whole infrastructure
deployment. The NVM collects the endpoint telemetry for better visibility into the following:

* The device—the endpoint, irrespective of its location

* The user—the one logged into the endpoint

* The application—what generates the traffic

* The location—the network location the traffic was generated on

* The destination—the actual FQDN to which this traffic was intended
When on a trusted network, AnyConnect NVM exports the flow records to a collector such as Cisco
Stealthwatch or a third-party vendor such as LiveAction, which performs the file analysis and provides a Ul
interface. Another third-party vendor such as Splunk may also provide a Ul interface to see the reports. Since

most enterprise IT administrator want to build their own visualization templates with the data, we provide
some sample base templates through a Splunk app plugin.

NVM on Mobile AnyConnect

The Network Visibility Module (NVM) is included in the latest version of the Cisco AnyConnect Secure
Mobility Client for Android, Release 4.0.09xxx, available in the Google playstore. NVM is supported on
Samsung devices running Samsung Knox version 2.8 or later. No other mobile devices are currently supported.

Network Visibility on Android is part of the service profile configurations. To configure NVM on Android,
an AnyConnect NVM profile is generated by the AnyConnect NVM Profile Editor, and then pushed to the
Samsung mobile device using Mobile Device Management (MDM). The AnyConnect NVM Profile Editor
from AnyConnect release 4.4.3 or later is required to configure NVM for mobile devices.

Guidelines

* NVM is supported on Samsung devices running Samsung Knox version 2.8 or later. No other mobile
devices are currently supported.

* On mobile devices, connectivity to the collector is supported over IPv4 only. IPv6 is not supported.

* Data collection on Java based apps is not supported.

Configure NVM for Mobile

Before You Begin
NVM for Mobile requires the following:

Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0
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NVM Profile Editor  [JJ|}

» Samsung devices that are running Samsung Knox 2.8 or later, which requires Android 7.0 or later. These
devices must also be configured using an MDM solution.

» The AnyConnect Profile Editor from AnyConnect 4.4.3 or later. Earlier releases do not support mobile
NVM configurations.

* TND (Trusted Network Detection) configured in the AnyConnect VPN Profile, and we recommend you
set your Trusted Servers.

Procedure

Open the NVM Profile Editor.

Set the parameters and options for your network environment.
See the NVM Profile Editor, on page 33 topic for details, field definitions, and choices. Be sure to specify
this is a Mobile NVM Profile.

Note Some collected fields are empty because they do not apply to Android or are unsupported. See the
field descrjptions for detajls.
The follow1lng are t % mo%fle spem1 ic fields:
* KNOX only—To specify collection of data from the KNOX workspace only.
* Acceptable Use Policy—To make the remote user aware of data collection activities.
Save the NVM Profile.

The profile is saved as a Base64 encoded file with extension .b64.

Use the .b64 NVM profile with your MDM facilities to push this configuration to your mobile devices.
Note  Using MDM is the only way to configure the mobile NVM capabilities. The NVM Profile cannot be
obtained at connectivity time like the VPN Profile.

What to Do Next

Verify that the collector is receiving data.

NVM Profile Editor

In the profile editor, configure the IP address or FQDN of the collection server. You can also customize the
data collection policy choosing what type of data to send, and whether data is anonymized or not.

The mobile Network Visibility Module can establish a connection using IPv4 only. IPv6 connectivity is not
supported.
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Note  The Network Visibility Module sends flow information only when it is on the trusted network. By default,
no data is collected. Data is collected only when configured as such in the profile, and the data continues
to be collected when the endpoint is connected. If collection is done on an untrusted network, it is cached
and sent when the endpoint is on a trusted network. NVM uses the TND feature of VPN to learn if the
endpoint is in a trusted network. Also, if VPN is in a connected state, then the endpoint is considered to
be on the trusted network, and the flow information is sent. The NVM-specific system logs show TND
use. Refer to AnyConnect Profile Editor, Preferences (Part 2) for information about setting the TND
parameters.

* Desktop or Mobile—Determines whether you are setting up NVM on a desktop or mobile device.
Desktop is the default.

* Collector Configuration
°IP Address/FQDN—Specifies the [Pv4 address/FQDN of the collector.

° Port—Specifies at which port number the collector is listening.

» Cache Configuration

> Max Size—Specify the maximum size the database can reach. The cache size previously had a
pre-set limit, but you can now configure it within the profile. The data in the cache is stored in an
encrypted format, and only processes with root privileges are able to decrypt the data.

Once a size limit is reached, the oldest data is dropped from the space for the most recent data.

> Max Duration—Specify how many days of data you want to store. If you also set a max size, the
limit which reaches first takes precedence.

Once the day limit is reached, the oldest day's data is dropped from the space for the most recent
day. If only Max Duration is configured, there is no size cap; if both are disabled, the size is capped
at SOMB.

* Periodic Flow Reporting(Optional, applies to desktop only)—Check to enable periodic flow reporting.
Reporting of flows (such as server connections or downloads) will occur at the interval you configure,
while on a trusted network or over VPN. Periodic flow reporting is disabled by default.

* Aggregation Interval—You can customize the NVM timer to define when Cisco nvzFlow exports the
data. Specify the interval so that the collector environment is not overrun. The default is 5 seconds.

* Throttle Rate—Throttling controls at what rate to send data from the cache to the collector so that the
end user is minimally impacted. You can apply throttling on both real time and cached data, as long as
there is cached data. Enter the throttle rate in Kbps. The default is 500 Kbps.

The cached data is exported after this fixed period of time. Enter 0 to disable this feature.

* Collection Mode—Specify when data from the endpoint should be collected by choosing collection
mode is off, trusted network only, untrusted network only, or all networks.

* Collection Criteria— You can reduce unnecessary broadcasts during data collection so that you have
only relevant data to analyze. Control collection of data with the following options:

° Broadcast packets and Multicast packets (Applies to desktop only)—By default, and for
efficiency, broadcast and multicast packet collection are turned off so that less time is spent on
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backend resources. Click the check box to enable collection for broadcast and multicast packets
and to filter the data.

> KNOX only (Optional and mobile specificy—When checked, data is collected from the KNOX
workspace only. By default, this field is not checked, and data from inside and outside the workspace
is collected.

* Data Collection Policy—You can add data collection policies and associate them with a network type
or connectivity scenario. You can apply one policy to VPN and another to non-VPN traffic since multiple
interfaces can be active at the same time.

When you click Add, the Data Collection Policy window appears. Keep these guidelines in mind when
creating policies:

° By default, all fields are reported and collected if no policy is created or associated with a network
type.

» Each data collection policy must be associated with at least one network type, but you cannot have
two policies for the same network type.

» The policy with the more specific network type takes precedence. For example, since VPN is part
of the trusted network, a policy containing VPN as a network type takes precedence over a policy
which has trusted as the network specified.

° You can only create a data collection policy for the network that applies based on the collection
mode chosen. For example, if the Collection Mode is set to Trusted Network Only, you cannot
create a Data Collection Policy for an Untrusted Network Type.

> Name—Specify a name for the policy you are creating.

> Network Type—Determine the collection mode, or the network to which a data collection policy
applies, by choosing VPN, trusted, or untrusted. If you choose trusted, the policy applies to the
VPN case as well.

°Include/Exclude

° Type—Determine which fields you want to Include or Exclude in the data collection policy.
The default is Exclude. All fields not checked are collected, and no fields are checked.

° Fields—Determine which fields will be part of your data collection policy. Based on the
network type and the fields included or excluded, NVM collects the appropriate data on the
endpoint.

See Collection Parameters for NVM, on page 36 for details.

For AnyConnect release 4.4 (and later), you can now choose Interface State and SSID, which
specifies whether the network state of the interface is trusted or untrusted.

> Optional Anonymization Fields—If you want to correlate records from the same endpoint
while still preserving privacy, choose the desired fields as anonymized, and they are sent as
the hash of the value rather than actual values. A subset of the fields is available for
anonymization.

Fields marked for include or exclude are not available for anonymization; likewise, fields
marked for anonymization are not available for include or exclude.
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* Acceptable Use Policy (Optional and mobile specific)—Click Edit to define an Acceptable Use Policy
for mobile devices in the dialog box. Once complete, click OK. A maximum of 4000 characters is

allowed.

This message is shown to the user once after NVM is configured. The remote user does not have a choice
to decline NVM activities. The network administrator controls NVM using MDM facilities.

The following parameters are collected at the endpoint and exported to the collector:

Table 1: Endpoint Identity

Parameter

Description / Notes

Virtual Station Name

Empty for Android, not provided by Samsung.

UDID Universally Unique Identifier. Uniquely identifies the endpoint
corresponding to each flow. This UDID value is also reported
by Hostscan in Desktop, and ACIDex in Mobile.

OS Name

OS Version

SystemManufacturer

System Type Set to arm for Android.
x86 or x64 for other platforms.

OS Edition

Table 2: Interface Information

Parameter Description / Notes
Endpoint UDID Same as UDID.
Interface UID

Interface Index

Interface Type

Interface Name
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Parameter

Description / Notes

Interface Details List

State and SSID, attributes of InterfaceDetailsList. Indicate the
network state of the interface (trusted or untrusted), and the SSID
of the connection.

Interface MAC address

Windows and Mac OS only
Empty for Android, not supported.

Table 3: Flow Information

Protocol Identifier

Description / Notes

Source IPv4 Add

Destination IPv4 Addr

Source Transport Port

Destination Transport Port

Source [Pv6 Addr Empty for Android, not supported.

Destination IPv6 Addr Empty for Android, not supported.

Start Sec The absolute timestamp of the start or end of the flow.
End Sec

Flow UDID Same as UDID.

Logged In User Empty for Android, not supported.

Logged In User Account Type

Windows and Mac OS only.
Empty for Android, not supported.

Process Account

Empty for Android, not supported.

Process Account type

Windows and Mac OS only.
Empty for Android, not supported.

Process Name

Process Hash

Parent Process Account

Empty for Android, not supported.
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Protocol Identifier Description / Notes

Parent Process Account Type Windows and Mac OS only.
Empty for Android, not supported.

Parent Process Name

Parent Process Hash Set to 0 for Android.

DNS Suffix Configured on the interface associated with the flow on the
endpoint.

L4ByteCountln

L4ByteCountOut

Destination Hostname Actual FQDN that resolved to the destination IP on the endpoint

Interface UID

Module Name List Empty for Android, not supported.

Module Hash List Empty for Android, not supported.

Troubleshoot AnyConnect on Mobile Devices

Step 1
Step 2
Step 3

[ ] Cisco AnyConnect Mobile Platforms Administrator Guide, Release 4.0

Before You Begin

Enable logging on the mobile device and follow the troubleshooting instructions in the appropriate User Guide:
* Android User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0
* Apple i0OS User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0.x
* BlackBerry User Guide for Cisco AnyConnect Secure Mobility Client, Release 4.0.x

If following those instructions does not resolve the issue, try the following:

Procedure

Determine whether the same problem occurs with the desktop client or another mobile OS.

Ensure that the proper licenses are installed on the ASAs.

If certificate authentication is failing, check the following:

a) Ensure that the correct certificate is being selected.

b) Ensure that the client certificate on the device has Client Authentication as an Extended Key Usage.

c) Ensure that the certificate matching rules in the AnyConnect profile are not filtering out the user’s selected
certificate.


https://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/user/guide/b_Android_AnyConnect_User_Guide_4-0-x.html
http://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/user/guide/b_Apple_iOS_AnyConnect_User_Guide_4-0-x.html
http://www.cisco.com/c/en/us/td/docs/security/vpn_client/anyconnect/anyconnect40/user/guide/b_BlackBerry_AnyConnect_User_Guide_4-0-x.html
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Even if a user selected the certificate, it is not used for authentication if it does not match the filtering rules
in the profile.

d) If your authentication mechanism uses any associated accounting policy to an ASA, verify that the user
can successfully authenticate.

e) Ifyou see an authentication screen when you are expecting to use certificate-only authentication, configure
the connection to use a group URL and ensure that secondary authentication is not configured for the
tunnel group.

Step4 On Apple iOS devices, check the following.

a) Ifthe VPN connection is not restored after the device wakes up, ensure that Network Roaming is enabled.
b) Ifusing Connect on Demand, verify certificate-only authentication and a Group URL are configured.

What to Do Next

If problems persist, enable logging on the client and enable debug logging on the ASA. For details, refer to
the release-appropriate Cisco ASA 5500-X Series Next-Generation Firewalls, Configuration Guides.
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